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CarQ Flutter Apps
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Welcome to CarQ Flutter
App Documentation
Firstly, a huge thanks for purchasing our product, your support is truly appreciated!

We are more than happy to assist with any queries you have. this documentation is

for a basic overview and about how to generate builds using this. Read this

document thoroughly if you are experiencing any difficulties.

Kind Note: This is a Codebase to build your app upon (Not a No-code Drag n' Drop

App builder)

For Support or any sort of communication, Please read this first .

https://docs.saasmonks.in/how-to-write-valid-request-for-support/
https://docs.saasmonks.in/how-to-write-valid-request-for-support/
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Mobile Configuration
& Build Generation
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Prerequisites

• Flutter v3.19.6  (EXACT VERSION)

https://docs.flutter.dev/release/archive?tab=windows

• Git for Windows

https://git-scm.com/downloads

• Android Studio Narwhal (JDK Runtime version: 21.0.6, this can be seen in its 

About page) 

https://developer.android.com/studio/archive

• XCode (for MacOS)

• Knowledge of above mentioned topics

https://docs.flutter.dev/release/archive?tab=windows
https://docs.flutter.dev/release/archive?tab=windows
https://git-scm.com/downloads
https://git-scm.com/downloads
https://developer.android.com/studio/archive
https://developer.android.com/studio/archive
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Application Introduction
Apps are built with Flutter Cross Platform Framework. So they will work on Android

& iOS as well.

For the Best User & Development Experience we recommand you use the complete

package from provided by us instead of one app from our store and other apps

from someone else. Because our backend & apps shares the API already. & It will

be convient on update release as well.
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Setting up Flutter
For Windows Users :-

To install and run Flutter, your development environment must meet these minimum

requirements:

• Operating Systems: Windows 10 or later (64-bit), x86-64 based.

• Disk Space: 1.64 GB (does not include disk space for IDE/tools).

• Tools: Flutter depends on these tools being available in your environment.

◦ Windows PowerShell 5.0  or newer (this is pre-installed with Windows 10)

◦ Git for Windows  2.x, with the Use Git from the Windows Command

Prompt option.

If Git for Windows is already installed, make sure you can run git
commands from the command prompt or PowerShell.

1- Download the following installation bundle to get the 3.19.6 Stable release of the

Flutter SDK:

Download Flutter SDK v3.19.6

2- Extract the zip file and place the contained flutter  in the desired installation

location for the Flutter SDK (for example, C:\src\flutter).

You are now ready to run Flutter commands in the Flutter Console.

System requirements

Get the Flutter SDK

Update your path

https://docs.microsoft.com/en-us/powershell/scripting/install/installing-windows-powershell
https://docs.microsoft.com/en-us/powershell/scripting/install/installing-windows-powershell
https://git-scm.com/download/win
https://git-scm.com/download/win
https://storage.googleapis.com/flutter_infra_release/releases/stable/windows/flutter_windows_3.19.6-stable.zip
https://storage.googleapis.com/flutter_infra_release/releases/stable/windows/flutter_windows_3.19.6-stable.zip
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If you wish to run Flutter commands in the regular Windows console, take these

steps to add Flutter to the PATH  environment variable:

• From the Start search bar, enter ‘env’ and select Edit environment variables for

your account.

• Under User variables check if there is an entry called Path:

◦ If the entry exists, append the full path to flutter\bin  using ;  as a

separator from existing values.

◦ If the entry doesn’t exist, create a new user variable named Path  with the

full path to flutter\bin  as its value.

You have to close and reopen any existing console windows for these changes to

take effect.

From a console window that has the Flutter directory in the path (see above), run

the following command to see if there are any platform dependencies you need to

complete the setup:

This command checks your environment and displays a report of the status of your

Flutter installation. Check the output carefully for other software you might need to

install or further tasks to perform (shown in bold text).

For example:

C:\src\flutter>flutter doctor

[-] Android toolchain - develop for Android devices
    • Android SDK at D:\Android\sdk
    ✗ Android SDK is missing command line tools; download from 
https://goo.gl/XxQghQ
    • Try re-installing or updating your Android SDK,
      visit https://flutter.dev/setup/#android-setup for detailed 
instructions.

Run flutter doctor
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The following sections describe how to perform these tasks and finish the setup

process. Once you have installed any missing dependencies, you can run the 

flutter doctor  command again to verify that you’ve set everything up correctly.

To install and run Flutter, your development environment must meet these minimum

requirements:

• Operating Systems: macOS (64-bit)

• Disk Space: 2.8 GB (does not include disk space for IDE/tools).

• Tools: Flutter uses git  for installation and upgrade. We recommend installing 

Xcode , which includes git , but you can also install git  separately .

1- Download the following installation bundle to get the 3.16.4 Stable release of the

Flutter SDK:

2- Extract the file in the desired location, for example:

3- Add the flutter  tool to your path:

This command sets your PATH  variable for the current terminal window only. To

permanently add Flutter to your path, see Update your path .

$ cd ~/development$ unzip ~/Downloads/flutter_macos_3.19.6-stable.zip

$ export PATH="$PATH:`pwd`/flutter/bin"

For iOS Users :-

System requirements

Get the Flutter SDK

https://developer.apple.com/xcode/
https://developer.apple.com/xcode/
https://git-scm.com/download/mac
https://git-scm.com/download/mac
https://docs.flutter.dev/get-started/install/macos#update-your-path
https://docs.flutter.dev/get-started/install/macos#update-your-path
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You are now ready to run Flutter commands!

Run the following command to see if there are any dependencies you need to install

to complete the setup (for verbose output, add the -v  flag):

This command checks your environment and displays a report to the terminal

window. The Dart SDK is bundled with Flutter; it is not necessary to install Dart

separately. Check the output carefully for other software you might need to install

or further tasks to perform (shown in bold text).

For example:

The following sections describe how to perform these tasks and finish the setup

process.

Once you have installed any missing dependencies, run the flutter doctor

command again to verify that you’ve set everything up correctly.

This is only suggested for advanced use cases.

You can also use git directly instead of downloading the prepared archive. For

example, to download the stable branch:

[-] Android toolchain - develop for Android devices    • Android SDK at 
/Users/obiwan/Library/Android/sdk    ✗ Android SDK is missing command 
line tools; download from https://goo.gl/XxQghQ    • Try re-installing 
or updating your Android SDK,      visit 
https://flutter.dev/setup/#android-setup for detailed instructions.

$ git clone https://github.com/flutter/flutter.git -b stable

Run flutter doctor

Downloading straight from GitHub instead of using an
archive
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Update your path, and run flutter doctor . That will let you know if there are

other dependencies you need to install to use Flutter (e.g. the Android SDK).

If you did not use the archive, Flutter will download necessary development

binaries as they are needed (if you used the archive, they are included in the

download). You may wish to pre-download these development binaries (for

example, you may wish to do this when setting up hermetic build environments, or

if you only have intermittent network availability). To do so, run the following

command:

For additional download options, see flutter help precache .

You can update your PATH variable for the current session at the command line, as

shown in Get the Flutter SDK. You’ll probably want to update this variable

permanently, so you can run flutter  commands in any terminal session.

The steps for modifying this variable permanently for all terminal sessions are

machine-specific. Typically you add a line to a file that is executed whenever you

open a new window. For example:

1. Determine the path of your clone of the Flutter SDK. You need this in Step 3.

2. Open (or create) the rc  file for your shell. Typing echo $SHELL  in your

Terminal tells you which shell you’re using. If you’re using Bash, edit 

$HOME/.bash_profile  or $HOME/.bashrc . If you’re using Z shell, edit 

$HOME/.zshrc . If you’re using a different shell, the file path and filename will be

different on your machine.

3. Add the following line and change [PATH_OF_FLUTTER_GIT_DIRECTORY]  to be the

path of your clone of the Flutter git repo:

4. Run source $HOME/.  to refresh the current window, or open a new terminal

window to automatically source the file.

5. Verify that the flutter/bin  directory is now in your PATH by running:

Verify that the flutter  command is available by running:

$ export PATH="$PATH:[PATH_OF_FLUTTER_GIT_DIRECTORY]/bin"

Update your path
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macOS supports developing Flutter apps in iOS, Android, and the web (technical

preview release). Complete at least one of the platform setup steps now, to be able

to build and run your first Flutter app.

To develop Flutter apps for iOS, you need a Mac with Xcode installed.

1. Install the latest stable version of Xcode (using web download  or the Mac App

Store ).

2. Configure the Xcode command-line tools to use the newly-installed version of

Xcode by running the following from the command line:

This is the correct path for most cases, when you want to use the latest version

of Xcode. If you need to use a different version, specify that path instead.

3. Make sure the Xcode license agreement is signed by either opening Xcode

once and confirming or running sudo xcodebuild -license  from the command

line.

Versions older than the latest stable version may still work, but are not

recommended for Flutter development. Using old versions of Xcode to target

bitcode is not supported, and is likely not to work.

With Xcode, you’ll be able to run Flutter apps on an iOS device or on the simulator.

$ sudo xcode-select --switch 
/Applications/Xcode.app/Contents/Developer$ sudo xcodebuild -
runFirstLaunch

Platform setup

iOS setup

Install Xcode

Set up the iOS simulator

https://developer.apple.com/xcode/
https://developer.apple.com/xcode/
https://itunes.apple.com/us/app/xcode/id497799835
https://itunes.apple.com/us/app/xcode/id497799835
https://itunes.apple.com/us/app/xcode/id497799835
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To prepare to run and test your Flutter app on the iOS simulator, follow these steps:

1. On your Mac, find the Simulator via Spotlight or by using the following

command:

2. Make sure your simulator is using a 64-bit device (iPhone 5s or later) by

checking the settings in the simulator’s Hardware > Device menu.

3. Depending on your development machine’s screen size, simulated high-screen-

density iOS devices might overflow your screen. Grab the corner of the

simulator and drag it to change the scale. You can also use the Window >

Physical Size or Window > Pixel Accurate options if your computer’s resolution

is high enough.

• If you are using a version of Xcode older than 9.1, you should instead set the

device scale in the Window > Scale menu.

1. Download and install Android Studio .

2. Start Android Studio, and go through the ‘Android Studio Setup Wizard’. This

installs the latest Android SDK, Android SDK Command-line Tools, and Android

SDK Build-Tools, which are required by Flutter when developing for Android.

3. Run flutter doctor  to confirm that Flutter has located your installation of

Android Studio. If Flutter cannot locate it, run flutter config --android-
studio-dir  to set the directory that Android Studio is installed to.

To prepare to run and test your Flutter app on an Android device, you need an

Android device running Android 8 (API level 27) or higher.

Android setup

Install Android Studio

Set up your Android device

https://developer.android.com/studio
https://developer.android.com/studio
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1. Enable Developer options and USB debugging on your device. Detailed

instructions are available in the Android documentation .

2. Windows-only: Install the Google USB Driver .

3. Using a USB cable, plug your phone into your computer. If prompted on your

device, authorize your computer to access your device.

4. In the terminal, run the flutter devices  command to verify that Flutter

recognizes your connected Android device. By default, Flutter uses the version

of the Android SDK where your adb  tool is based. If you want Flutter to use a

different installation of the Android SDK, you must set the ANDROID_SDK_ROOT
environment variable to that installation directory.

To prepare to run and test your Flutter app on the Android emulator, follow these

steps:

1. Enable VM acceleration  on your machine.

2. Launch Android Studio, click the AVD Manager icon, and select Create Virtual

Device…

• In older versions of Android Studio, you should instead launch Android

Studio > Tools > Android > AVD Manager and select Create Virtual

Device…. (The Android submenu is only present when inside an Android

project.)

• If you do not have a project open, you can choose Configure > AVD

Manager and select Create Virtual Device…

3. Choose a device definition and select Next.

4. Select one or more system images for the Android versions you want to

emulate, and select Next. An x86 or x86_64 image is recommended.

5. Under Emulated Performance, select Hardware - GLES 2.0 to enable hardware

acceleration .

6. Verify the AVD configuration is correct, and select Finish.

For details on the above steps, see Managing AVDs .

7. In Android Virtual Device Manager, click Run in the toolbar. The emulator starts

up and displays the default canvas for your selected OS version and device.

Set up the Android emulator

https://developer.android.com/studio/debug/dev-options
https://developer.android.com/studio/debug/dev-options
https://developer.android.com/studio/run/win-usb
https://developer.android.com/studio/run/win-usb
https://developer.android.com/studio/run/emulator-acceleration
https://developer.android.com/studio/run/emulator-acceleration
https://developer.android.com/studio/run/emulator-acceleration
https://developer.android.com/studio/run/emulator-acceleration
https://developer.android.com/studio/run/emulator-acceleration
https://developer.android.com/studio/run/managing-avds
https://developer.android.com/studio/run/managing-avds
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Before you can use Flutter, you must agree to the licenses of the Android SDK

platform. This step should be done after you have installed the tools listed above.

1. Make sure that you have a version of Java 8 installed and that your JAVA_HOME
environment variable is set to the JDK’s folder.

Android Studio versions 2.2 and higher come with a JDK, so this should already

be done.

2. Open an elevated console window and run the following command to begin

signing licenses.

3. Review the terms of each license carefully before agreeing to them.

4. Once you are done agreeing with licenses, run flutter doctor  again to

confirm that you are ready to use Flutter.

$ flutter doctor --android-licenses

Agree to Android Licenses
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Connect Application
to Server or Admin
Make sure you have HTTPS enabled (secured) hosting.

Go to Project Directory

Open File

\lib\network\apis.dart

Go to Project Directory

Open File

\lib\network\apis.dart

Go to Project Directory            

Open File

User App 

Owner/Shop/Vendor App

Employee App 
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\lib\network\apis.dart

Note: for some server directory, it may need /public/  to be added before /api

Note: Everytime you modify the URL, you will have to re-run the command given

below.

• Execute the command : 

flutter pub get && flutter pub run build_runner build --delete-
conflicting-outputs
Then wait for the completion of the process.

• While your app's source code is open in the IDE, & Enulator is Running

Run the following command in the terminal:

flutter run

• Run flutter test  to execute the unit tests.

• This will run all the test files in the test folder.

• It will ensure that your backend is connected to the app.

• It should show "All tests passed!" in the console.

Test
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Change Application name

• Go to below path and change the name android:label="Your_App_Name" 

• File Location is : - project/android/app/src/main/AndroidManifest.xml.

• Go to below path and change app name which seems like this 

<string>Your_App_Name</string>

• File Location is : - project/ios/Runner/Info.plist.

Execute below commands in project/terminal.

<application
    android:label="Your_App_Name"        //Change this line
    android:usesCleartextTraffic="true"
    android:icon="@mipmap/ic_launcher">

<key>CFBundleName</key>
<string>Your_App_Name</string>

Change Application name

For Android

For iOS

Change Application package name (User,
Owner and Employee)
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1. flutter pub add change_app_package_name

2. flutter pub get

3. flutter pub run change_app_package_name:main xyz.package.name

Note : - (replace your package name with this "xyz.package.name",  'in." is not

allowed inside package name as it is kotlin's reserved keyword).

• Modify the bundle identifier from your Info.plist  file inside your ios/Runner
directory.

We can find CFBundleIdentifier  used multiple places. Just search 

CFBundleIdentifier in your IDE and replace its value with our new bundle

identifier.

<key>CFBundleIdentifier</key>
<string>xyz.packagename</string> // change this line to your bundle-
identifier

Change Bundle-identifier(User, Owner and
Employee)
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Localization (optional)
These are the steps to add transaltions languages to the apps.

Caution: These are intermediate level code changes, make sure your code has a

backup in case you make mistake.

Make sure you are following consistancy with casings.

Process is the same for Customer App, Owner App & Employee App:

First, create the JSON file of the language you want to add; in the following folder.

You can duplicate en.json & then rename as per your language.

Folder::: lib->localization->languages.

Step 1:
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Replace all english values with translated values. Change only values, not keys.

(showns as dashes below)

Add your language cobnstant variable as shown below.

File:::  lib->localization->localization_constant.dart.

Add your language related code on following locations.

File:::  lib->localization->localization_constant.dart.

Step 2:

Step 3:

Step 4:
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Then Open main.dart file and add new language code with Country code.

in lib/Profile/settings_screen.dart  Add new language number with

incremented numeric value

example: Language(3,’Language Name’,’Country Code’,’Language Code’)

In lib\Localization\language_localization.dart  add your new language name

variable

Step 5:

Step 6:

Step 7:
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Done.
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Run The App

Select File from top list menu, and chose open folder then select the project folder.

1- Locate the main Android Studio toolbar:

2- In the target selector, select an Android device for running the app. If none are

listed as available, select Tools> Android > AVD Manager and create one there. For

details, see Managing AVDs .

3- Click the run icon in the toolbar, or invoke the menu item Run > Run.

After the app build completes, you’ll see the app on your device.

Starter app

Using Android Studio

Open the app files

Run the app

Using VS Code Studio

https://developer.android.com/studio/run/managing-avds
https://developer.android.com/studio/run/managing-avds
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Select File from top list menu, and chose open folder then select the project folder.

1- Locate the VS Code status bar (the blue bar at the bottom of the window):

2- Select a device from the Device Selector area. For details, see Quickly switching

between Flutter devices .

• If no device is available and you want to use a device simulator, click No

Devices and launch a simulator.

Warning: You may not see Start iOS Simulator option when you click No Devices

in VS Code. If you are on Mac then you may have to run following command in

terminal to launch a simulator.

In Android it is not possible to launch iOS simulator.

• To setup a real device, follow the device-specific instructions on the Install

page for your OS.

3- Invoke Run > Start Debugging or press F5.

4- Wait for the app to launch — progress is printed in the Debug Console view.

After the app build completes, you’ll see the app on your device.

Open the app files

Run the app

https://dartcode.org/docs/quickly-switching-between-flutter-devices
https://dartcode.org/docs/quickly-switching-between-flutter-devices
https://dartcode.org/docs/quickly-switching-between-flutter-devices
https://flutter.dev/docs/get-started/install
https://flutter.dev/docs/get-started/install
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Note: Some functionality may not work on iOS Simulator. but it will work on a

physical device.
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Install App To Your Android Device

Steps for: How to install application in android device

1. Connect your android device via data transfer supported cable.

2. Open setting and turn on Developer option and turn on USB Debugging.

3. In android studio you can see your device connected at right hand side of

screen.

4. then you need to just click on Green color play button to run it. it will take 3-6

minute as per your system configuration.

Install app to your android device
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How to Generate APK file
1. At bottom of android studio : TODO, Dart Analysis, and Terminal buttons

available

2. Click on the Terminal button

3. execute command:

flutter build apk --target-platform android-arm,android-arm64 --split-
per-abi

4. after 3 to 6 minutes you can get APK file.
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How to Generate Signed APK
1. Open Android studio

2. Click on "Open an existing Android Studio project"

3. Go to specific path of your code : [Project_Folder] -> android

4. Select Android
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Click OK.

Wait while build process finishes successfully.

After that :
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Select Build Menu -> Generate Signed Bundle/APK..
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Here you have 2 options:

• Android App Bundle

• APK

Select Android App Bundle to Generate Signed Bundle.
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You can see above dialog box :

If you are generating signed bundle/apk for first time, then you need to CREATE

NEW KEYSTORE PATH

Click on "Create new..." You will see this dialog box
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Fill-up all the necessary Details : Key store path , Key store Password, Key store

confirm Password, KEY Alias, Alias Password, Alias confirm password,

validity(years), Certificate: First & Last Name

Other details are optional.

Select key store path :

NOTE : (Select a specific path where you want to store KEY STORE File. This file

will use while every time when you want to publish apk or Update application to

Google Play store. So, Save it on safe location)

Set Password and Confirm Password
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Key-----------

Alias: Set Alias Name

Alias Password: Set Alias Password

Alias Confirm Password: Set Alias Confirm Password

Validity : in years

Certificate :

First name and Last Name:

AFTER Filling up all the details, Click OK

Then you can see previous dialog box with key store path filled as your given data.

Enter Keystore password , key alias , and key Password as you given while creating

keystore path.
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Click NEXT

Here you need to select build Variants : release

Signature versions : V1 and V2

Select V2 Signature version for secure apk file from reverse engineering.

Click Finish.

Generating Signed apk will take 3-6 minute.
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How to publish APK
to Google play store

Here are steps for Android application publishing on the Google play store:

To publish your application on the google play store you need to have a Developer

Account on Google Play

Create a Developer account using the below link:

https://play.google.com/apps/publish

The First Step to publish APK to google play store, We need to generate Signed

APK. (Regular Build APK can not be published on the google play store.)

If you have knowledge of how to generate a signed APK then you can proceed to

the next page.

How to publish APK to Google play store

https://play.google.com/apps/publish
https://play.google.com/apps/publish
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Upload APK/App bundle
to Google play store
After Successfully Generation of Signed APK, you can publish it on Google play

store.

As pervious mentioned you must have Google developer / google play store

account to complete the process of it. Create and set up your app - Play Console

Help Starting August 2021, new apps will be required to publish with the Android

App Bundle on Google Play.

New apps larger than 150MB can use either Play Asset Delivery or Play Feature

Delivery. Reasupport.google.com

Thankyou

https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
https://support.google.com/googleplay/android-developer/answer/9859152?hl=en
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How to publish an app to appstore

In this tutorial, we will be releasing Flutter iOS application on TestFlight using

XCode. This is a beginner’s guide for iOS release. This tutorial is intended for first

time users who want to release apps built using Flutter to App Store.

To follow along with this tutorial, you need an Apple developers account, Flutter

application and a MacOS device with XCode.

Navigate to https://developer.apple.com/account  and login to your Apple

Developers account.

Go to Identifiers and create a new ID. This bundle ID is required to create app in

App Store.

Releasing Flutter iOS app to TestFlight using
XCode

Create new App Bundle Identifier

https://developer.apple.com/account
https://developer.apple.com/account
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Select App IDs and continue

Select App to Register

Provide description, bundle ID and check capabilities you need in you app
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Once done, you will have an Identifier created for the app.

Go to Profiles section and create new profile for provisioning

Select Distribution > App Store

Create new provisioning Profile
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Select App ID and continue, this will create a new provisioning profile.

Now, download that profile in local machine. This will be used in publishing app to

Test Flight.

Create a new application in App Store
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Navigate to App Store connect https://appstoreconnect.apple.com/apps  and

login. Go to Apps and create a New App

Fill required details in the form and click on Create

https://appstoreconnect.apple.com/apps
https://appstoreconnect.apple.com/apps
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Once done, you will have an app created. Now go to TestFlight and fill mandatory

details
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App Center allows only updating existing apps. In order to use automated release

process, you will need to upload your app to TestFlight from Xcode only once.

Build your flutter app for iOS.

Open your app in Xcode. Go to Product > Archive

Submitting the app to TestFlight for the First
time
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Once the archive is created, you can distribute app to app store in TestFlight

Select App Store Connect as distribution method
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Here, you can create a new Certificate to sign your app.

If you do that, please export that certificate with private key to a .p12 file. This is

needed in App Center to sign your apps.
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Thank you
End of Documentation

Thank you for purchasing our product

We appreciate your Purchase again.

For server/hosting issues or queries please contact your hosting provider support

instead.


